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Bigger picture –

Zoom in: 

The biopharma industry is seeing 
renewed interest in Alzheimer's drug 
development after the approval of 
Leqembi in 2022. 

Athira Pharma is developing 
fosgonimeton for mild to moderate 
Alzheimer's disease, as well as for 
Parkinson's disease dementia and Lewy 
body dementia. 

Zoom out: 

The company faced challenges in 2022 
but is still moving forward with its pipeline 
and has generated interest from 
investors and strategics. 

360-degree perspective: 

Athira Pharma's drug development for 
Alzheimer's disease is one piece of a 
larger puzzle in the biopharma industry. 

As a CFO, it's important to consider the 
company's pipeline and challenges 
within the context of the industry as a 
whole. 

Understanding the interests of investors 
and strategics can provide insight into 
the company's potential future 
opportunities and challenges. 

Athira Pharma

What's going on: 

Athira Pharma is developing a drug for 
Alzheimer's disease and is currently in a 
phase 2/3 study with a readout in early 
2024. 

The company faced challenges in 2022, 
including a phase 2 flop and a proxy fight 
against an investor. 

Despite these challenges, there is 
growing interest in the company, as 
management has had numerous 
meetings with investors and strategics. 

Why do I care: 

As a CFO of a biopharma company, it's 
important to stay informed about 
developments in the industry. 

Athira Pharma's drug development for 
Alzheimer's disease is an example of the 
type of work being done in the space. 

Understanding the challenges faced by 
companies like Athira can inform 
decision-making and strategy for other 
biopharma companies. 

Athira's management had "75 or more" 
meetings with investors and strategics, 
indicating growing interest in the 
company. 
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SECTION 01

Biotech Buzz – The 3 Must-Know Headlines of the Month

Explore the Most Exciting Biotech Breakthroughs with us.

1 Biotech's Big 3 M&A 
Targets to Watch in 2023



Bigger picture –

Zoom in: 

• Icosavax's VLP technology is gaining 
attention for its potential to create 
stronger immune responses, which 
could have significant implications for 
vaccine development. 

• Phase 1 data for IVX-121 showed 
sustained immunologic response at six 
months, suggesting the technology's 
durability lives up to the hype. 

Zoom out: 

• IVX-A12's phase 1 trials will provide 
further insight into the technology's 
potential for other diseases. 

360-degree perspective: 

• Icosavax's VLP technology has been 
gaining attention and could potentially 
revolutionize vaccine development. 

• The technology has faced some 
criticism after underwhelming data for 
its COVID-19 vaccine, but phase 1 data 
for IVX-121 showed promising results. 

• The company has another vaccine in 
phase 1 trials, with a top-line readout 
expected in mid-2023. 

• With an affordable market cap, 
Icosavax has the potential to be an 
attractive acquisition target for larger 
pharmaceutical companies. 

Icosavax

What's going on: 

• Icosavax's VLP technology has been 
gaining attention for its potential to 
create stronger immune responses. 

• The technology initially received 
criticism after underwhelming data 
from the company's COVID-19 vaccine 
in March 2022. 

• However, phase 1 data for IVX-121 
showed promising results, restoring 
faith in the VLP platform. 

• Icosavax's CEO is optimistic about the 
technology's potential. 

Why do I care: 

• Icosavax's VLP technology has the 
potential to create stronger immune 
responses than other vaccine 
platforms. 

• The technology could be applied to a 
variety of diseases, including RSV and 
human metapneumovirus. 

• If IVX-A12's phase 1 trials are successful, 
it could further cement Icosavax's
reputation. 

• The company has an affordable $400 
million market cap. 
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Bigger picture –

Zoom in: 

• Karuna Therapeutics has developed a 
potential revolutionary therapy for 
treating schizophrenia and psychosis 
symptoms with its KarXT candidate. 

Zoom out: 

• Karuna's stock price has doubled since 
the success of its phase 3 trial, 
resulting in a market cap of $7 billion. 

360-degree perspective: 

• Karuna Therapeutics has promising 
potential in the development of KarXT, 
a potentially revolutionary therapy for 
schizophrenia and psychosis 
symptoms. 

• However, it remains to be seen if a Big 
Pharma will make an offer for Karuna 
or if the company will choose to launch 
KarXT on its own, as it currently has $1.2 
billion in cash and equivalents. 

Karuna Therapeutics 

What's going on: 

• Karuna Therapeutics is generating 
hype for its KarXT candidate, which 
showed success in treating 
schizophrenia and psychosis 
symptoms in a phase 3 trial. 

• Mizuho analysts have called KarXT a 
potential "gamechanger" with 
predicted global peak sales of $6.8 
billion across several indications. 

• Karuna plans to file for FDA approval 
for KarXT in mid-2023 and has ongoing 
phase 3 trials assessing the drug's 
effects on acute psychotic symptoms 
or safety over a year. 

• The company also has a phase 3 trial 
evaluating KarXT for psychosis related 
to Alzheimer's disease. 

Why do I care: 

• KarXT has shown promising results in 
treating schizophrenia and psychosis 
symptoms, which could potentially 
revolutionize the treatment paradigm 
in psychiatry. 

• The drug has multiple ongoing phase 3 
trials and could receive FDA approval 
in mid-2023, making it a potential 
investment opportunity. 
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In our upcoming newsletter, we'll reveal the 
remaining M&A targets of 2023, ensuring you 
stay in the know. 

Subscribe now to catch the next edition and 
receive exclusive updates on the latest and most 
promising biotech partnerships and acquisitions.



Challenges: 

• Murky waters due to FDA and Biogen's 
controversial approval of Aduhelm, 
which was a commercial flop with high 
price and questionable safety and 
efficacy. 

• FDA's reputation questioned after 
ignoring advice to reject Aduhelm and 
its "inappropriate" communications 
with Biogen regarding approval. 

• Safety concerns due to two trial patient 
deaths, though Eisai denies drug 
responsibility. 

• Questions on meaningfulness of 27% 
slowing of disease progression. 

Mechanism: 

• Works by removing amyloids, a protein 
that builds up in the brain and is 
believed to be a culprit behind 
Alzheimer’s. 

Drug: Lecanemab/Leqembi 

Companies: Eisai/Biogen 

Used for: Alzheimer’s disease 

Sales: Est. 2028 sales: $3 billion 

1

2 Top 5 most anticipated 
drug launches of 2023.



Challenges: 

• U.S. commercial success for SRP-9001 
is by no means guaranteed 

• Securing full reimbursement in the U.S. 
is likely to take time 

• Safety and long-term efficacy of gene 
therapy are still uncertain 

• Gene therapies will be expensive to 
make and use, and pricing will be an 
issue 

• Lack of precedents in the new therapy 
area makes predicting demand 
difficult 

• Reimbursement for an expensive 
product will be a problem 

Top 10 most anticipated drug launches of 2023 

Mechanism: 

• Designed to deliver the 
microdystrophin-encoding gene into 
muscle tissue to prompt production of 
the microdystrophin protein

Drug: SRP-9001 

Companies: Sarepta/Roche 

Used for: Gene therapy for Duchenne 
muscular dystrophy 

Sales: Estimated 2028 sales of $2.2 billion
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Challenges: 

• Geographic atrophy has no FDA-
approved treatments 

• Previous efforts to treat geographic 
atrophy have failed 

• Risk of Apellis facing similar challenges 

• Internal issues, including changes to 
FDA review process, have caused 
investor concern 

• Clinical trial data for pegcetacoplan's
efficacy in treating geographic atrophy 
is uncertain 

• Uncertainty around whether an 
advisory committee will be formed for 
the drug's approval 

• Potential competition from Iveric Bio's 
C5 agent Zimura

Top 10 most anticipated drug launches of 2023 

Mechanism: 

• Pegcetacoplan is a complement factor 
C3 inhibitor 

• Pegcetacoplan is already approved as 
Empaveli for paroxysmal nocturnal 
hemoglobinuria 

Drug: Intravitreal pegcetacoplan

Company: Apellis 

Used for: Complement factor C3 
inhibitor for geographic atrophy 

Estimated sales: $2 billion by 2028 

Potential market: 1 million Americans 
with geographic atrophy 

Potential peak annual sales: $3 billion 
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Challenges: 

• Delayed FDA approval due to the need 
for longer data on patients using the 
drug 

• Clinical hits and misses, with a slight 
win on one disease scale and a failure 
on another 

• Mixed results from 2021 data showing a 
significant slowing of decline in 
Alzheimer's patients, but a failure on a 
commonly used scale to diagnose 
dementia due to Alzheimer's 

• FDA's willingness to approve more 
drugs for Alzheimer's disease may be 
auspicious for Lilly 

Top 10 most anticipated drug launches of 2023 

Mechanism: 

• Reduces brain amyloid plaque levels 
by 65.2% at six months compared to 
baseline, according to head-to-head 
trial against Aduhelm

• Lilly is now planning for a "traditional 
approval" with the FDA by midyear 

Drug: Donanemab

Company: Eli Lilly  

Used for: Anti-amyloid monoclonal 
antibody for Alzheimer’s disease 

Sales: Estimated 2028 sales of $1.9 
billion 

Downgraded from last year's 
prediction of $6 billion by 2026 
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Resources: 

GSK's vaccine showed statistically 
significant and clinically meaningful 
reductions in cases of lower respiratory 
tract disease caused by RSV in adults 
aged 60 years and older 

Pfizer, Moderna, and J&J are also 
developing RSV vaccines 

Challenges: 

Previous attempts at RSV vaccines have 
faced setbacks and flops 

GSK had to abandon plans to develop a 
vaccine for infants due to safety concerns 
in its maternal vaccine trial 

GSK will face competition from Pfizer, 
Moderna, and J&J in the RSV vaccine 
market 

Top 10 most anticipated drug launches of 2023 

Mechanism: 

RSV is a respiratory virus that can cause 
serious complications and sometimes be 
fatal in vulnerable populations such as 
the elderly and children under 5 

GSK's RSVPreF3 OA vaccine aims to 
prevent cases of lower respiratory tract 
disease caused by RSV in adults aged 60 
years and older. 

Drug: RSVPreF3 OA 

Company: GSK 

Used for: Vaccine for older adults for 
respiratory syncytial virus 

Sales: Estimated 2028 sales of $ 1.8 Billion 
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Stay ahead of the curve with our newsletter! In 
the upcoming edition, we'll unveil the next 5 
incredible drug launches of 2023. 

Don't miss out on this exclusive update -
Subscribe now to get the latest details delivered 
right to your inbox!



Top 10 most anticipated drug launches of 2023 

Figure: The presented graph highlights the projected top 10 drug sales for the year 2028, categorized by various 
diseases. The data showcases the estimated revenue potential of these drugs, indicating the significant impact 
they are expected to have on the healthcare industry in the coming years. This information provides valuable 
insights for healthcare stakeholders and investors, allowing them to make informed decisions and allocate 
resources accordingly



The biotech industry in 2023 has 
seen a significant amount of 
funding from a diverse range of 
sources, indicating strong 
investor confidence in the 
potential for growth and 
innovation in this sector. 

Big Picture:  

GenScript ProBio has raised a total of 
$220M in funding over 1 round. This was a 
Series C round raised on Jan 18, 2023. It is 
funded by 8 investors. China Industrial 
Asset Management and Hillhouse Capital 
Group are the most recent investors. 

Flare Therapeutics announced the 
successful closure of its Series B funding 
round, which raised $123 million. The 
company intends to use these funds to 
further develop its lead precision 
oncology asset, FX-909, specifically for 
the treatment of urothelial cancer. The 
funding round was oversubscribed, 
indicating strong investor interest in Flare 
Therapeutics' potential for growth and 
innovation in the oncology sector. 

Pathalys Pharma has recently secured 
$150 million in funding. The funds will be 
used to support phase 3 clinical trials for 
the company's primary drug candidate, 
which is being developed to treat end-
stage kidney disease. This financing 
represents a significant milestone for 
Pathalys Pharma, indicating investor 
confidence in the potential of its drug 
candidate to address a critical unmet 
medical need in the treatment of kidney 
disease. 

Aera Therapeutics has successfully 
raised a total of $193 million in combined 
Series A and B financings. Led by ARCH 
Venture Partners, GV, and Lux Capital, the 
funding will be used to expand the 
company's operations and accelerate its 
development efforts. Aera Therapeutics is 
focused on providing a proprietary 
protein nanoparticle delivery platform, 
and this significant investment 
underscores investor confidence in the 
company's potential for growth and 
innovation in the biotech industry. 

Figure: Please see next page for details

3 Biotech Financing 
Roundup 2023! 



Figure: The presented graphs illustrate the various types and amounts of funding that biotech companies have 
received, showcasing the diversity and scale of investment in this industry. This data highlights the continued 
interest and support from venture capitalists, private equity firms, strategic partners etc, emphasizing the 
significant role that funding plays in driving innovation and growth within the biotech sector.



Want to know who's investing in the hottest companies on the rise?  

Click below to get the names of the investors and all the juicy details on 
the next 20+ biotech giants valued at $240M! 

A look at Biotech 
investment - Top 10!

Company Name Funding Type Funding Amount Investors Name

GenScript ProBio Series C 220 M
Highlight Capital, Hillhouse 
Capital Group, Huatai Zijin 
Investment

Aera Therapeutics Series B 193 M
ARCH Venture Partners, 
Google Ventures, Lux 
Capital

Pathalys Pharma Series A 150 M Abingworth, Catalys Pacific, 
DaVita Venture Group

Flare Therapeutics Series B 123 M Agent Capital, Boxer 
Capital, Casdin Capital

Bicara Therapeutics Series B 108 M
Acorn Bioventures, Bioqube
Ventures, Eight Roads 
Ventures

HighTide Therapeutics Series C 107 M
China Development Bank 
Capital, Guangzhou Yuexiu 
Industrial Investment Fund, 
Yuthai Fund

Huisheng
Biopharmaceutical Series A 84 M

Baixing Bairong, 
Changchun Equity 
Investment Fund 
Management, JiLin Province 
Private Equity

Perceive Biotherapeutics Series B 78 M Braidwell, Catalio Capital 
Management, Deerfield,

Olatec Therapeutics Series A 40 M Advection Growth Capital, 
Sanders Morris Harris

Vivasure Medical Series D 32 M Haemonetics

Subscribe for more detail



Tips and tools for accurate 
Financial Planning & Analysis

Financial Fitness - The FP&A Best Practices You Need to Know

Sl No. Formula Function

1 Custom keyboard 
shortcuts

(File > Options > Customize Ribbon > 
Keyboard Shortcuts)
Assign a keyboard shortcut to a 
command, such as CTRL + Shift + C, 
for copy formula.

Excel automatically copies the formula from 
the selected cell to the destination cells.

2 Conditional 
formatting

Highlight cells that meet a specific 
condition, such as values greater 
than 100. 
Home > Conditional Formatting > 
Highlight Cells Rules > Greater Than 
and enter "100" as the value.

Cells with values greater than 100 are 
highlighted in red.

3 Pivot tables
=PIVOT(TABLE)(data 
range,[field1],[field2],...)

The function of a Pivot Table is to summarize, 
analyze, and present large amounts of data in 
a meaningful and interactive way. It lets users 
filter, sort, and group data based on variables 
such as time periods, products, categories, or 
regions.

4 Data validation

(Data > Data Validation)
Select cell A1, go to Data > Data 
Validation > Allow: List, and enter 
"=Table1[Product]" as the source.

Create a dropdown list in cell A1 that allows the 
user to select a product name from a table.
This is useful for preventing errors caused by 
typing mistakes or incorrect data entry.

5 Freeze panes

(View > Freeze Panes)
Freeze the top row to keep headings 
visible while scrolling through large 
datasets.

The top row remains visible as the user scrolls 
through the rest of the data.

6 XLOOKUP

=XLOOKUP (lookup_value, 
lookup_array, return_array, 
[if_not_found], [match_mode], 
[search_mode])

An improved version of the VLOOKUP and 
HLOOKUP formulas is commonly used in 
financial modelling. It allows you to search for a 
specific value in a table and return the 
corresponding value from another column in 
the same row.

7
IF & COUNTIF 
function

(=COUNTIF (A1:A10, "condition")) & (=IF 
(condition, actual value, false value))

The COUNTIF function in Excel counts the 
number of cells within a specified range that 
meet certain criteria or condition.

The IF function returns a different value based 
on whether the logical test is true or false.

8 AVERAGE function (=AVERAGE (A1:A10)) The AVERAGE function returns the average sales 
for the specified product.

9
MAX/MIN 
functions (=MAX (A1:A10) or =MIN (A1:A10))

The MAX and MIN functions in Excel are used to 
find the highest and lowest values in a range of 
cells, respectively.

10 TEXT Function (=TEXT (value, "format"))

The TEXT function in Excel is used to convert a 
numeric value into a formatted text string. It 
can format dates, times, currencies, 
percentages, and other values.

We bring you the best practices, tips, and tricks to help you master your finances and stay on top. 

SECTION 02



Supply Chain Spotlight

Cost-Saving Strategies: CFOs Forge 
Strong Business Partnerships with 
Supply Chain Leaders

How can CFOs establish a strong and 
effective partnership with the supply 
chain? 

CFOs should spend at least 20-25% of 
their time working with the supply chain 
to foster collaboration and ensure 
alignment. 

Success Pathway: 

• Work closely with supply chain teams 
to develop a clear understanding of 
the supply chain's key drivers and risks. 

• Identify opportunities for cost savings 
and efficiency improvements within 
the supply chain. 

• Establish regular communication 
channels with supply chain 
stakeholders to monitor performance 
and collaborate on strategic initiatives. 

• Work with the supply chain to develop 
a comprehensive risk management 
strategy that considers potential 
disruptions to the supply chain. 

• Encourage cross-functional 
collaboration and communication 
between the finance and supply chain 
teams. 

• Support the development of 
technology and tools that can help 
optimize the supply chain and 
enhance financial performance. 

• Foster a culture of continuous 
improvement within the supply chain 
and across the organization. 

Try spending time 
for the supply chain 
(Time is Money) 

SECTION 03
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Allocate finance resources to 
the supply chain 

SECTION 03
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How can finance support the supply chain?  

By embedding finance business partners in the supply chain, with a hard reporting line 
back to finance and a dotted reporting line into the functional head.  

SUCCESS PATHWAY: 

• Allocate resources to support supply chain initiatives and investments, such as 
implementing new technology or expanding into new markets. 

• Develop a robust financial analysis framework that enables the supply chain team to 
evaluate the costs and benefits of different options and make data-driven decisions. 

• Provide guidance on financial metrics that are relevant to the supply chain, such as 
inventory turnover, cash-to-cash cycle time, and working capital management. 

• Establish financial controls and risk management processes that mitigate financial 
risks within the supply chain, such as supplier defaults or supply chain disruptions. 

• Collaborate with the supply chain team to develop and implement a budget that 
aligns with the organization's strategic goals and objectives. 

• Monitor and analyse financial performance data to identify areas where the supply 
chain can improve performance or reduce costs. 

• Provide training and education to the supply chain team on financial management 
and analysis, to enable them to make better financial decisions and understand the 
impact of their actions on the organization's overall financial performance. 



Participate in the 
sales and 
operations 
planning process 

SECTION 03
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How can CFOs provide value to the S&OP 
process? 

By providing insight and information to 
help ensure alignment across functions 
and with the broader strategy. 

Success pathway: 

• Align the S&OP process with strategic 
goals and financial objectives 

• Provide financial insights and 
guidance to the S&OP team 

• Develop and implement a 
comprehensive budget and 
contingency plan 

• Monitor financial performance and 
identify areas for improvement 

• Foster cross-functional collaboration 
and communication 

• Provide financial training and 
education to the S&OP team 

How can CFOs prevent inconsistent data 
driving decisions?  

By taking ownership of data and 
presenting a single version of the truth.  

Success pathway: 

• Establish clear data governance 
policies and procedures that ensure 
data accuracy, completeness, and 
consistency. 

• Work with IT and data management 
teams to implement data quality 
controls and validation checks. 

• Develop a centralized data repository 
that stores all relevant data in a 
standardized format. 

• Use data visualization and analytics 
tools to identify and resolve 
inconsistencies in data. 

• Encourage cross-functional 
collaboration and communication to 
ensure that data is consistent across 
departments. 

• Provide training and education to 
employees on data management best 
practices and how to use data to make 
informed decisions. 

• Establish a data governance 
committee or team that includes 
representatives from across the 
organization to oversee data quality 
and consistency. 

• Develop a process for regularly 
reviewing and updating data to ensure 
that it remains accurate and up to 
date. 

Own your 
organization’s 
data 
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Stay involved throughout the 
investment cycle 

SECTION 03
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How can CFOs help strengthen the business case for 
investments?  

By being involved throughout the investment life 
cycle, from choosing an asset for investment through 
to managing its performance, retiring it, or 
reinvesting in it.  

Help build an integrated 
operating model 6

How can CFOs build an integrated, cost-efficient, 
effective structure? 

CFOs and supply chain leaders can build an 
integrated operating model that puts the company in 
a better position to create shareholder value. 

Success pathway: 

Three layers: physical structures such as facilities and equipment, people including 
talent and skills, and organizational structures such as reporting lines and 
decision-making processes. Also need to consider indirect taxes, transfer pricing, 
the effective tax rate, and legal structures as part of this approach. 

By addressing all these layers, CFOs and supply chain leaders can work together to 
build an operating model that is cost-efficient, effective, and aligned with the 
company's overall strategy and goals.  

This can help improve performance, enhance shareholder value, and provide a 
competitive advantage in the marketplace. 

Success pathway: 

Work with the supply chain team to develop a comprehensive implementation plan 
that considers all aspects of the investment, including supply chain logistics, 
production processes, and customer demand. 

Provide guidance on financing options, such as debt financing or equity financing, 
and help the supply chain team develop a financing strategy that aligns with the 
organization's overall financial goals. 

Collaborate with the supply chain team to develop a business case that outlines the 
investment's objectives, benefits, risks, and implementation plan. 

Present the business case to key stakeholders, such as the executive team or board 
of directors, and provide financial insights to support the investment decision. 



Focus the supply 
chain on the 
metrics that 
matter 

SECTION 03
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How can CFOs ensure clarity around the 
real objectives of the organization?  

Work with supply chain leaders to identify 
the most important metrics that will drive 
performance and support the 
achievement of the organization's goals. 

• Avoid the temptation to measure 
everything, and instead focus on a few 
key metrics that are truly meaningful 
and actionable. 

• Ensure that the metrics selected are 
aligned with the organization's overall 
strategy, and that they provide a clear 
line of sight between supply chain 
performance and business results. 

• Implement an effective performance 
management system that tracks 
progress toward the selected metrics 
and provides regular feedback to 
supply chain leaders on performance. 

How can CFOs ensure alignment of 
incentives to meet the objectives of the 
business? 

CFOs should ensure that incentives align 
with the overall objectives of the business, 
rather than just those of individual 
functions. 

• Work with cross-functional teams to 
identify the specific incentives that will 
drive performance and support the 
achievement of the organization's 
goals. 

• Avoid the temptation to focus solely on 
short-term incentives, and instead 
design incentives that support long-
term success. 

• Ensure that incentives are consistent 
with the organization's values and 
culture, and that they promote 
collaboration and teamwork. 

Identify 
performance 
incentive 
misalignment 
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Consider 
centralizing 
business functions 

SECTION 03

9
How can CFOs achieve economies of 
scale? 

By centralizing key business functions 
such as procurement, the supply chain 
can benefit from increased efficiency and 
streamlined processes, reducing the time 
and resources required to manage these 
functions. 

• A centralized operating model can 
provide greater visibility into supply 
chain operations and performance, 
allowing for more informed decision-
making and improved collaboration 
across teams. 

• Also, can help to better manage risks 
and minimize disruptions, such as by 
having a centralized procurement 
team that can quickly respond to 
supply chain disruptions or changes in 
demand. 

How can CFOs identify and mitigate risks 
in the supply chain? 

By gaining visibility into secondary and 
tertiary layers of the supply chain and 
ensuring appropriate control over 
external partners.  

• To identify potential risks in the supply 
chain, CFOs should conduct a 
thorough risk assessment that includes 
an evaluation of all suppliers and 
partners, as well as an analysis of 
potential threats such as natural 
disasters, geopolitical instability, and 
regulatory changes. 

• Many companies only have visibility 
into their first-tier suppliers, but risks 
can exist at deeper levels in the supply 
chain. CFOs should work with supply 
chain partners to gain visibility into 
secondary and tertiary layers of the 
supply chain to identify potential risks. 

Look deep in the 
supply chain for 
risks 

10

Click here and subscribe to get the latest 
stories and gain access to a wealth of 
knowledge and expertise!

Subscribe



White Paper by buyingsimplified.com

Stay tuned and get 
ready to go global! 
That's all for this month's newsletter - we hope you found it engaging and 
informative. As always, we welcome your feedback and suggestions for future 
content. Thanks for reading! 

Best Regards, 
The Buying Simplified Team

Subscribe
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